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About Sitebuilder 

Sitebuilder consists of two parts: Wizard and Administrator Panel. 

With the Sitebuilder Wizard, you can create sites by simply choosing the design preset 
you like and adding text and images. And then you can add picture galleries, blogs and 
online stores with a few clicks. You do not need to know any markup or scripting 
languages to have a site. 

The Administrator Panel is a tool for managing and maintaining web sites created in 
the Wizard. 
 

About This Guide 

This guide instructs you how to create and publish sites on the Internet using the 
SWsoft Sitebuilder program. 

This guide covers the following steps of creating and publishing sites: 

1 Creating site design (see page 17)  

2 Creating and editing site structure (see page 23)  

3 Creating and editing site content (see page 29)  

4 Publishing a site on the Internet (see page 81)  

 
 

Who Should Read This Guide 

The target audience of this guide is regular users of Sitebuilder as well as guests, who 
are working with Sitebuilder in the guest mode, creating trial sites without publishing 
them on the Internet. 
 

C H A P T E R  1  
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Typographical Conventions 

The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information Example 

Special Bold 

 

Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the QoS tab. 

Titles of chapters, sections, 
and subsections. 

Read the Basic Administration 
chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to 
designate a command line 
placeholder, which is to be 
replaced with a real name or 
value. 

The system supports the so 
called wildcard character 
search. 

Monospace  The names of style sheet 
selectors, files and directories, 
and CSS fragments.  

The license file is located in the 
httpdocs/common/license  

directory. 

Preformatted  On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

# ls ïal /files  

total 14470  

Preformatted Bold  What you type, contrasted with 
on-screen computer output. 

# cd /root/rpms/php  

 
 

Feedback 

If you have found a mistake in this guide, or if you have suggestions or ideas on how to 
improve this guide, please send your feedback to userdocs@swsoft.com. Please 
include in your report the guide's title, chapter and section titles, and the fragment of 
text in which you have found an error. 

mailto:userdocs@swsoft.com
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This chapter describes your first steps with the Sitebuilder Wizard. 

In this chapter: 

Overview of Main Steps to Create Site .............................................................. 8 
Logging In to Sitebuilder .................................................................................... 9 
Learning Sitebuilder Interface ............................................................................ 10 
Starting to Work with Sitebuilder ........................................................................ 14 
Getting Help ...................................................................................................... 15 
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Getting Started with Sitebuilder 
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Overview of Main Steps to Create Site 

As a rule, the process of working on a site includes three main stages: planning, 
implementation, and site updating or maintenance. 

Planning: The first and most essential stage in any project is planning. Before starting 
with Sitebuilder, think about the purpose of your site and its target audience. After this, 
decide where your site will be stored, or, in Internet terminology, hosted. This stage is 
beyond the scope of this document. Because Sitebuilder is often provided with a web 
hosting package, we assume that you already have a web space for publishing your 
site. Then, you create a structure of your future site and prepare its contents, including 
text and graphics. The planning stage is extremely important because it eventually 
determines the usefulness of your site. 

Implementation: The next stage is the implementation of your site. The five-step 
Sitebuilder Wizard takes you through the entire process of creating your site, from 
initial design to publishing and maintenance. The following is an overview of the main 
steps required to create a site using Sitebuilder:  

1 To create a site, open the Sitebuilder Wizard. You can start working with the Wizard 
anonymously, without supplying login and password.  

2 Complete the first four Wizard steps (select the design, create the site structure, 
add site contents, add site modules and provide extra information for search 
engines).  

3 Go to the Publish step and start the publication process. If you do not have a 
Sitebuilder account and work with the program in demo mode, the site you create is 
temporary and cannot be published on the Internet until you buy hosting. After you 
purchase hosting services from your provider, you will be provided with a domain 
name. The Sitebuilder provider will point your Sitebuilder account to your domain 
name, and after publication, your site will be available on the Internet. 

Maintenance: When you complete the above steps, your site becomes available for 
visitors. It is critical to keep your site content fresh because this is a good way to show 
your attitude to customers and services. Therefore, update your site on a regular basis. 
All you need to do is to log in to the Sitebuilder, edit the content, and click Publish. 
Sitebuilder will transfer the updated content to your hosting location. 

For detailed instructions on what to do on every step of creating your site, see the 
following chapters. 
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Logging In to Sitebuilder 

Anonymous users, who can work in the Sitebuilder Wizard in demo-mode only, do not 
need to provide any access credentials - they are taken to the Wizard by following a 
promotional link to the trial version of the Wizard (the link is distributed by Sitebuilder 
provider over the Internet or in some other ways). 

ü To log in to the Sitebuilder Wizard using your site owner account: 

1 Open your Internet browser. 

2 Enter the URL that your Sitebuilder provider has given to you into the 
address bar of your browser. 

For example, http://hostname:por t/ Admin  

3 Enter you user name and password and click OK. 

4 You can proceed to the Wizard in the following ways:  

Á If your Sitebuilder administrator has already registered a site for you, then on 

the navigation pane, click Sites and click the  Edit site in Wizard icon opposite 
the site name. 

Á If no site is registered for your account yet: 

Á Go to http://hostname:port/Wizard  or click Go to SWsoft Sitebuilder 

Wizard on the Desktop - a site (with default name and empty publishing 
settings) will be automatically registered in the Administrator Panel, and you 
will be taken to the Wizard. 

Á Go to navigation pane > Sites > Add New Site and specify all required 

parameters to register your site. Click OK. Now click the  Edit site in Wizard 
icon opposite the site name 
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Learning Sitebuilder Interface 

In Sitebuilder, a site is created in five steps. Each step has its own working and 
navigation principles, which will be covered in respective sections further in this guide. 
Here we will outline the general principles of working with the Sitebuilder Wizard 
interface, and enumerate elements present on all Sitebuilder screens. 

 

Figure 1: Sitebuilder Wizard Interface 

Every Sitebuilder Wizard window contains the following elements: 

1 Logotype image. The default logotype is a Sitebuilder image linked to the SWsoft 
official site. This image can be customized by your Sitebuilder provider. 

2 Top help string, which provides short instructions about the operations you can do on 
this page and displays the result of your last action. 

3 Shortcuts used to switch between the five Sitebuilder Wizard steps. The step you are 
currently on is highlighted in color. 

4  Feedback button, which enables you to submit your opinion or suggestions on 
Sitebuilder usability and functionality. 

5  Support button, which by default, opens Sitebuilder Online Server Support 
screen on the SWsoft official site, where you can fill in the form to request the help 
of SWsoft technical support team. This link can be customized by your Sitebuilder 
provider. 

6  Help button, which opens the online version of this guide. 

7  Go to Admin Panel button, which takes you to the Sitebuilder Administrator Panel.  

8  Log out button, which finishes the current session with the Sitebuilder Wizard. 
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Note: Buttons Go to Admin Panel and Log out are not shown to users working in 
Sitebuilder in demo mode (as anonymous users).  

9 Work area, which displays the interface options available on the current step. 

10  Back button, which enables you to get to the previous step of the Wizard (you 
can also return to another step by selecting the corresponding tab in the top frame 
area). 

11  Preview button, which allows you to preview the site at any stage of its creation. 

12  Next button, which takes you to the next step of creating your site (you can also 
go to the next step by clicking the required tab in the top frame area).  
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Working with Lists 

When setting up page or block modules on the Edit step of the Sitebuilder Wizard, you 
will see lists of various system objects (blog posts, online store orders, etc.).  

In such a list, each object record is a table row displaying the object name and the 
relevant parameters of the object (for example, for each forum topic, the author of the 
topic, the category the topic belongs to, the date of last the update, and the number of 
replies to the topic are displayed). Above and below each list, the total number of items 
contained in the list is displayed. Below the list, you can adjust the number of items to 
be displayed per page (10, 25, or 100). In multi-page lists, you can navigate between the 
pages by clicking the page number shortcuts above and below the list. To go to the 
first/last page of the list, click First Page or Last Page, accordingly. 

In lengthy lists, you can find items using the search function, or sort items by the 
available parameters. To find an item, type a search criterion into the input box above 
the list, and click Search. The list will show the items matching the search criterion. To 
return back to viewing all items, click Show All.  

 

Figure 2: Searching for Objects 

In some lists, you can filter items by a number of parameters by selecting one of them 
from the drop-down box (for example, on the Orders tab of your eShop page, you can 
filter out orders of certain status: All, New, Paid, Processed, Backorder, Cancelled, 
Completed, Failed). 

 

Figure 3: Filtering Objects 

Note: All the above described principles also apply to the list of design template 
categories on the Design step of the Sitebuilder Wizard. For information on using these 
options on the Design step, read section Creating Site Design (see page 17). 

To choose a list object for further operation, select the check box to the left of the 
object's name. 
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Figure 4: Selecting Particular Objects in a List 

To choose all objects in the list, select the check box at the head of the column. 

 

Figure 5: Selecting All List Objects at Once 

To perform operations with certain objects in a list, select the required objects and click 

an operation shortcut above the list (for example,  Remove Selected). 

In the list of guestbook messages, the status of a message is indicated by a status icon 

in the Status (S) column (not archived  or archived ).  

In most lists, individual operation shortcuts are displayed for each item. For example, 
for each product category on the Categories tab on the eShop page, there are arrows 
( and ) used to change the order in which the categories are displayed on the site 

page; and the  Edit icon used to open the categories in editing mode. 

In most lists, you can configure or edit a list object by: 

Á Clicking the object name, if it is clickable (for example, the post names on the 
Content tab of the Blog page) 

Á Clicking the  Edit icon for this object in the list (for example, for a product on the 
Products tab of the eShop page) 

In some lists, you will also see shortcuts to managing the objects' dependent items - 
such as the View/Edit Comments shortcut for each blog post on the Content tab of the Blog 
page. 
 



 

 Getting Started with Sitebuilder 14 

 

Starting to Work with Sitebuilder 

The Overview page provides quick access to and contains short description of each of 
the five steps required for creating a site in Sitebuilder. 

 

Figure 6: The Sitebuilder Wizard Overview Page 

The five Sitebuilder Wizard steps are as follows: 

1 Start. Enables you to choose whether to create a site from scratch or create a site 
using one of the proposed site templates (site-blog, site-photo gallery, etc.).  

2 Design. Enables you to configure your site layout, color scheme, menu style, logo 
and banner, as well as to set up text elements appeared at the background of your 
site, such as title phrase or copyright notice. 

3 Pages. Enables you to add and structure web pages on your site. 

4 Edit. Enables you to create and edit your site content. 

5 Publish. Enables you to put your site online. 

For anonymous users, on the Overview page, the  Interface language box is displayed 
allowing to select the language of the Sitebuilder Wizard interface. 

To start creating your site, click Start.  
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Getting Help 

The Sitebuilder help system has been created to assist you in solving problems you 
might encounter when creating your site. To find the information you need, you can do 
the following: 

Á Use on-screen help. It is the easiest and quickest way to get instant help with your 
immediate tasks. Using help topics will not interrupt your work flow. The Top help 
string contains short instructions on the operations that are available on the current 
page and displays the result of the last command you have performed on the 
Sitebuilder page. 

Á Use FAQ. For the fastest way to solve your problems with Sitebuilder, check out the 
Sitebuilder FAQ page (http://faq.swsoft.com), which provides instant access to 
solutions for a variety of issues. Select the Sitebuilder category and view the list of 
FAQs related to Sitebuilder. 

Á Go to online forum. If you failed to solve your problem using the FAQs published on 
SWsoft site, join our online forum (http://forum.swsoft.com/). Here, all users can post 
questions, exchange ideas, and troubleshoot common problems. Note that SWsoft 
does not provide official support through this forum. 

Á Contact technical support. If you have any problems or questions that are not 

covered in the user documentation or FAQs, click the  Support button at the top 
right of the Sitebuilder window to submit a request to your support representative. 

 

 

http://faq.swsoft.com/
http://forum.swsoft.com/
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The first step of creating site with Sitebuilder is to choose whether you want to start 
creating your site from scratch or use one of proposed site templates (the so-called site 
families). By default, there are two site templates available - blog and image gallery, 
but the Sitebuilder administrator can extend this list by creating custom site templates 
and including them in your service plan. 

To choose the type of a created site, go to the Start step and click the required site 
family to select it. 

The Start page looks as follows: 

 

Figure 7: Step 1. Choosing the Site Type 

The chosen site family is indicated with the  sign.  

Having selected a site family, click Next at the bottom of the screen to proceed to 
configuring the design of your site. 

 

C H A P T E R  3  

Choosing Type of Created Site 
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In Sitebuilder, you can build the graphic design of your site by combining the provided 
presets with your custom design elements which you can upload to Sitebuilder. 
Sitebuilder offers design presets of several types, including: design templates, color 
schemes, page banners and site menu styles. The custom elements you can upload 
are the page banner and logo. Besides uploading your own banner and logo, you 
personalize your site by specifying your own the site title, subtitle and footer message. 
Below you will find a step-by-step instruction on designing your site in Sitebuilder. 

The Sitebuilder Design step screen looks as follows. 

 

Figure 8: Step 2. Creating Site Design 

The work area of the screen contains the following elements: 

1 Design template selection area, which provides the functions facilitating the choice of 
a site design template (see page 19). When you choose to display All categories, this area 
shows all available design templates. 

2 Design template preview window displaying the currently selected template. Click 
this window for full-size preview of the template. The chosen design template, color 
scheme and menu style are shown in red frames in the corresponding areas of the 
screen. 

3 Color schemes area, where you can choose the colors for your site (see page 19).  

C H A P T E R  4  

Creating Site Design 
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4 Banners area enabling you to select or upload a banner for your site (see page 20).  

5 Menu styles area, where you can choose the appearance of the site menu (see page 20).  

6 Logo area enabling you to upload your custom logo (see page 21).  

7 Site info area where you can provide the information to be displayed within the banner and 
in the footer of your site pages (see page 21).  

8 The design template list navigation area.  

Read this chapter to learn how to use these options to create your site design. 

In this chapter: 

Selecting Design Template for Site ................................................................... 19 
Selecting Color Scheme .................................................................................... 19 
Selecting Banner ............................................................................................... 20 
Selecting Menu Style ......................................................................................... 20 
Uploading Logo ................................................................................................. 21 
Specifying Site's Title, Subtitle, and Footer Message ........................................ 21 
Buying Pictures from Fotolia .............................................................................. 22 
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Selecting Design Template for Site 

On this step, you choose the general graphic and layout concept of the site page - the 
site design template. For more convenience, design templates are grouped into 
categories - the most frequently encountered site types. Your choice of the design 
template defines the choice of available color schemes, menu styles and page banners 
further on this step.  

The list of available site design templates is determined by your service plan. 

ü To select a design template for your site: 

1 On the Design step, select a template category from the Category list.  

The default design template which goes with the category is displayed in the main 
design preview window; the alternative ones - in smaller windows beside the main 
window.  

2 Select a design template. 

Click the design template you like to select it for your site. The selected template 
appears in the main design preview window. By selecting a design template you 
can view the color schemes, menu styles and the page banner which go with it. 

To choose a design template on pure aesthetic grounds (not by category), select All 
categories to display all available templates and click the desired one to select it.  

Selecting Color Scheme 

For each design template, three color schemes are available. No custom color 
schemes can be uploaded to Sitebuilder.  

To select a color scheme for your site, on the Design step, in the Color schemes area, 
select the color scheme you like. The selected color scheme is outlined with a red 
frame. 
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Selecting Banner 

In Sitebuilder, banner is a large image of rectangular shape which serves as a central 
element of the page layout. Each design template offers a choice of available banners. 

ü To select a banner: 

1 On the Design tab, in the Banners area, click the down arrow to expand 
the list of available banners. 

2 Select the banner you need. 

 

You can also upload a custom banner for your site.  

ü To upload a banner: 

1 Click Browse in the Banners area. 

2 In the Browse window, find and select the banner image you want to 
upload. 

3 Click Open in the Browse window. 

4 Click Upload in the Banners area. 

 
 

Selecting Menu Style 

Menu style defines the visual appearance of the menu items on your site. 

To select a menu style, on the Design step, in the Menu styles area, select the style you 
like. The selected style is outlined with a red frame. 
 



 

 Creating Site Design 21 

 

Uploading Logo 

In Sitebuilder, logo is a small image displayed at the top of each page, within page 
banner. The maximum size of logo image is 320x320 pixels; the supported image files 
formats are *.bmp, *.gif, *.jpg, *.png. 

ü To upload a logo: 

1 On the Design step, click Browse in the Logo area. 

2 Select the logo image you want to upload from your computer. 

Prior to uploading the logo, observe the dimension and format requirements to the 
logo image. 

3 Click Open in the Browse window. 

4 Click Upload in the Logo area. 

To remove logo from your site design, click Clear. 

To restore logo to its default state, click Restore Default. 
 

Specifying Site's Title, Subtitle, and Footer 
Message 

Site title, subtitle, and footer message are text elements appeared at the background of 
your site: site title and subtitle are displayed within the site banner, and footer message 
is put at the bottom of every page of your site. 

To specify your site title, subtitle phrase and footer message, on the the Design step, fill 
in the fields in the Site info section: 

Á In the Site title field, provide a short description of your site. On business sites, this 
is usually a company name. 

Á In the Subtitle field, provide any phrase which reflects the concept and objectives of 
the site. This phrase will be displayed below the site title in smaller font. On 
business sites, this is usually a corporate slogan. 

Á In the Footer message field, provide the copyright notice or any other information of 
similar kind - disclaimers, contact information, etc., which you would like to place in 
the page footer. 
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Buying Pictures from Fotolia 

In Sitebuilder, you can buy images from Fotolia (http://www.fotolia.com/swsoft/) - the 
first worldwide social marketplace for royalty free stock images, directly from the 
Sitebuilder Wizard. As an SWsoft customer, you can a get 20% discount on Fotolia 
pictures.  

ü To purchase images from Fotolia: 

1 On the Design step, click the  Buy pictures shortcut. 

2 Follow the instructions provided on the Fotolia Web site to purchase 
images. 

 

 

http://www.fotolia.com/swsoft/
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A site consists of several pages linked together to present information in an ordered 
way. Using Sitebuilder, you can arrange the pages in the two levels of hierarchy: top 
level pages and second level pages. Therefore, before this stage you must clearly 
understand how you intend to structure your site.  

Note: The maximum number of pages you can create using Sitebuilder is regulated by 

your service plan.  

To facilitate your work with Sitebuilder, pages are grouped into page sets - pre-defined 
site structures designed for displaying certain types of content. The default page set of 
your site is determined by the type of site you chose on the Start page of the Sitebuilder 
Wizard.  

On the Pages step, you can build any possible site structure by organizing the available 
types of pages into a hierarchy which addresses your needs. Find out about the types of 
pages (see page 25) offered by Sitebuilder and about the process of adding pages (see 
page 27) and site structuring (see page 27). 

The Pages step screen provides the following functionalities to facilitate structuring your 
site: 

 

Figure 9: Step 3. Creating Site Structure 

C H A P T E R  5  

Creating Site Structure 
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1 Page sets area allows to choose a page set. The selected page set is shown in red 
frame.  

2 Standard pages area displays the structure of the page set chosen in the Page sets 

area. You can expand or collapse this section by clicking the  or  icons in the 
top bar of the section. 

3 Your site structure area shows the final structure of your site. 

4 Site regional and language options area allows you to set the site language and the 

format of numeric data. You can expand or collapse this section by clicking the  

or  icons. 

5 Special pages area displays all available types of pages which can be added to your 
site structure: one common text page, and all available page modules. You can 

expand or collapse this section by clicking the  or  icons. 

6  and  buttons allow you add or remove pages from the site 
structure. 

7 Page position area enables you to organize the hierarchy of pages (see page 26) in the 
site map, and to rename pages. 

Read this chapter to know how to use these options. 

In this chapter: 

Types of Pages ................................................................................................. 25 
Structuring Your Site ......................................................................................... 26 
Choosing Site Language and Customizing Settings for Display of Numbers, 
Currencies, Times and Dates ............................................................................ 28 
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Types of Pages 

In Sitebuilder, there are two types of pages: 

Á Standard (common) pages - ordinary pages used for displaying text information. 

Such pages are marked with  icons in the site map. 

Á Special pages - page modules which extend the site functionality. Each module is 
designed for a certain purpose and is identified by its own icon. There are the 
following types of page modules in Sitebuilder: 

Á  Blog (see page 48). Supports a standard set of blog functionality: posting, 
commenting, content categorizing, etc. A Blog page is very convenient for 
organizing the News, Events and similar pages of your site.  

Á  Image Gallery (see page 52). Supports image upload, batch image upload with 
group editing functions, etc. 

Á  File Download (see page 57). Allows to provide various content for download 
to your site visitors.  

Note: Each File Download page can hold only one file. To provide several files 

for download, add several File Download pages to your site structure.  

Á  eShop (see page 58). Supports basic online store functions: shopping cart, 
multi-currency, categorized product catalogue with thumbnail upload capability, 
shipping cost support. Provides integration with 6 payment systems, including 
PayPal, Authorize.Net, BluePay, 2Checkout.com. 

Á  Flash Intro (see page 67). A pre-designed flash introduction to your site. You 
can choose between several designs of the intro and insert your own text 
information into it. 

Note: The Flash Into module is the only page module that requires no database 

connection and therefore can be included in a static site. 

Á  Guestbook (see page 68). A standard guestbook. 

Á  Forum (see page 70). A standard forum engine which supports threading, 
categorizing, etc. 

Á  Registration (see page 73). Allows you to set up voluntary user authentication 
on your web site. 

The list of available modules is determined by your service plan. In Sitebuilder, you can 
add as many page modules of one kind to your site as you like (excepting Flash Intro 
and Registration).  
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Structuring Your Site 

You can build and edit your site structure on the Pages step of the Sitebuilder Wizard. 
To facilitate your work with Sitebuilder, pages are grouped into page sets - pre-defined 
site structures designed for displaying certain types of content. The default page set of 
your site is determined by the type of site you chose on the Start page of the Sitebuilder 
Wizard. You see this default page set highlighted in the list of page sets, its structure is 
displayed in the Your site structure box on the right. You can modify the proposed site 
structure as desired by adding pages from other page sets (or even whole page sets), 
renaming pages, changing pages hierarchy, or removing pages from the Your site 
structure box. 

The list of page sets available depends on your service plan and can be extended only 
by your Sitebuilder administrator. The structure of each page set is shown in the 
Standard pages area after you select the page set in the list. 

The Special pages area shows a list of special pages, or modules which you can add to 
your site, plus one common site page which you can use as an ordinary text page. To 
learn which modules are available, refer to Types of Pages (see page 25), earlier in this 
section. 
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Adding Pages 

ü To add pages to the site structure: 

1 Select the necessary pages in the Standard pages or Special pages area.  

Note: The module titles in the page set may differ from their original names. For 

example, a page  Photo of the Personal Page page set represents the  Image 
Gallery module. You can identify a module by its icon. 

2 Click .  

Or just drag and drop needed pages into the Your site structure box. 

You can add as many modules of one type to your site as you wish - except for the 
Flash Intro and Registration modules. These modules can be added to your site only 
once. 

Changing Position of Pages 

ü To change the pages hierarchy: 

1 Select the required page in the Your site structure box. 

2 Use required buttons in the Page position area: 

Á To move a page from the second level to the top level of the site structure, click 
Left. 

Á To move a page from the top level to the second level, click Right. 

Á To move a page up at the same level, click Up. 

Á To move a page down at the same level, click Down. 

 
 

Renaming Pages 

ü To rename a page: 

1 Select the page in the Your site structure box and click Rename. 

Or just double-click the page's name to make it editable. 

2 Provide a new name for the page. 

3 Press ENTER. 

If you choose to rename the page at a later stage, you can use the Page title field on the 
Edit step of the Sitebuilder Wizard. 
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Removing Pages 

To remove a page from the site map, select the page in the Your site structure box and 

click . 

Note: In Sitebuilder, you cannot delete all pages from the Your site structure area. In 
case you need to clear the space - for example, before setting up a completely new site 
structure, we recommend to select all pages, except one, delete them, add the 
necessary pages to the site, and then delete or reuse the old page.  
 

Choosing Site Language and Customizing 
Settings for Display of Numbers, Currencies, 
Times and Dates 

The language of Sitebuilder interface and the language of your site can be configured 
independently. You may need this option if you want to create a site in a language 
which is not in the list of available Sitebuilder interface languages. In that case, it is 
possible to select the desired language of your site on the Pages step. The choice of the 
language determines the format of numbers, the site currency, and also the format of 
date and time records everywhere on your site. 

ü To select the language for your site and the format of displaying numbers, currencies, 
times and dates: 

1 Go to the Pages step. 

2 Select the language of your site content and modules interface from 
the Interface language list. 

3 Select the type of formatting standard from the Standards and formats list. 

The sample of the selected standard is displayed under the Standards and formats 
list. 
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In Sitebuilder, creating your site content means creating the content of each page 
constituting your site, and setting up functional modules you add to your site. You can 
do all this on the Edit step of the Sitebuilder Wizard. 

The Sitebuilder editor is organized in such a way that the information you type on the 
pages and the design of the pages are independent. Therefore, you can completely 
change the design for a page after you had typed a text on this page, without having to 
retype the information. 

The Edit step screen is structured in the following way: 

 

 

Figure 10: Step 4. Populating Site with Content 

1 Site map area shows the site structure created on the Pages step of the Wizard. By 
selecting a page in this area, you open its content for editing in the work area of the 
screen. In this area you can also adjust the general page parameters in the site map (see 

page 30). To hide the Site map section, click the  Hide site map icon. To restore the 

Site map area on the screen, click the  Show site map icon. 

2 Work area provides access to different functions, depending on the type of the edited 
page: 

Á On ordinary text pages, the work area provides the space for creating the text 
content of the page (see page 33) with the help of the WYSIWYG editor, like on 
the screenshot above.  

C H A P T E R  6  

Populating Site with Content 
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Á On special pages, or page modules, the work area provides the module editor 
screen, where you can configure various parameters of the module on the 
respective tabs, and, in most cases, populate the module with content (for 
example, fill your online store catalogue with products). For information on 
working with lists of objects on module management pages, read section 
Working with Lists (see page 12). For more information about configuring and 
editing each module, see the respective sections further in this chapter. 

3 Modules area allows to embed block modules in text pages, by clicking and drag-
and-dropping the module icon to the required spot on the page. For some tips on 
using block modules, see section Working with Modules (on page 47). To hide the 

Modules section, click the  Hide modules icon. To restore the Modules area on the 

screen, click the  Show modules icon. 
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Setting Up Site Map 

If upon filling your site with content you decide to rename some pages, hide them in 
site navigation or provide them with some keywords or description to be used by 
search engines, you can do that on the Edit step, in the Site map area. 
 

Renaming Pages 

To rename a page, select it in the Site map area and provide a new name in the Page 
title field. This will rename the page in the site menu and in the browser's title bar. 
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Specifying Keywords to be Used by Search Engines 

The keywords should be carefully selected to reflect the page content, because they 
are used by search engines to find pages with requested information. 

To provide a page with keywords, select the necessary page in the Site map area and 
type the needed keywords in the Page keywords field. 

Providing Description to be Displayed in Search Results 

Description is displayed with the page title and URL when the page appears as the 
result of a user query on a search engine. Therefore, description should give the main 
idea of the page, so everyone could instantly understand what the page is about. 

To provide a page with description, select the necessary page in the Site map area and 
type the desired text in the Page description field. 
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Hiding Pages in Site Navigation 

In Sitebuilder, you can choose which site pages should be visible in site menu and 
which not. The page which you choose to be hidden will be accessible only by clicking 
a link placed on other pages of your site (or wherever you would like to place it). Note 
that when site visitor actually accesses a hidden page it appears in the site menu, and 
when they switch to another (not hidden) page, the hidden page disappears again. 

To hide a page in the site navigation menu, clear the Show this page in site map check 
box. In the Wizard interface, hidden pages are highlighted with grey color in the site 
map and in the site structure on the Pages step. You can hide both first and second 
level pages. 

To understand how hiding pages correlates with pages hierarchy, see the example 
below: 

Let the site structure look as follows: 

Á Page 1 

Á Page 2 (hidden) 

Á Page 3 

Á Page 3.1 (hidden) 

Á Page 3.2 

Á Page 4 (hidden) 

Á Page 4.1 

Á Page 4.2 (hidden) 

To understand the dependency of pages' visibility and position in the hierarchy, see the 
table below. 

Active Page* Visible Pages 

Page 1 Page 1, Page 3 

Page 2 Page 1, Page 2, Page 3 

Page 3 Page 1, Page 3, Page 3.2 

Page 3.1 Page 1, Page 3, Page 3.1, Page 3.2 

Page 3.2 Page 1, Page 3, Page 3.2 

Page 4 Page 1, Page 3, Page 4, Page 4.1 

Page 4.1 Page 1, Page 3, Page 4.1 

Page 4.2 Page 1, Page 3, Page 4.1, Page 4.2 

* active page is a page where site visitor is currently stands on 
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Working with Text 

This subsection describes the ways of working with textual information on your web 
pages. You will learn how to format characters and paragraphs, cut, copy, paste text, 
insert images and links, check spelling, and more. 
 

Applying Styles, Fonts, and Colors to Text 

ü To apply formatting to a text: 

1 On the Edit tab, select the web page where you want to edit the text.  

2 Select the portion of the text you want to change. 

3 Apply the necessary formatting options: 

Á Select a font from the Font list. 

Á Select a font size from the Size list. 

Á Select a style from the Paragraph style list. 

Á Click the  Foreground color icon to choose a font color. 

Á Click the  Background color icon to choose a background color. 

Á Click the  Bold,  Italic,  Underline, or  Strike through icons to make the text 
bold, italic, underlined, or strikethrough respectively. 

Á Click the  Subscript or  Superscript icon to make the text subscript or 
superscript respectively. 

4 To insert a special symbol into the text, click the  Insert Symbol icon 
and select a symbol. 
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Formatting Paragraphs 

ü To apply formatting to a paragraph: 

1 On the Edit tab, select the web page where you want to edit the text. 

2 Select the text which you want to format. 

3 Apply necessary formatting commands: 

Á To align the text, click the  Align left,  Align center,  Align right, or  Justify 
icon on the toolbar. 

Á To change the indentation of the selected text, click the  Indent or  Outdent 
icon on the toolbar. 

Á To insert a horizontal rule, place a cursor in any place on the page and click the 
 Horizontal Ruler icon. 

Á To start a new paragraph, click the  New Paragraph icon before the beginning of 
the new paragraph. 

 
 

Copying and Moving Text 

ü To copy or move text: 

1 On the Edit tab, select the web page where you want to edit the text.  

2 Select the needed piece of the text. 

3 To move the text, click the  Cut icon 

4 To copy the text, click the  Copy icon. 

5 Place the cursor where you want the text to appear. 

6 Click the  Paste icon. 
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Finding and Replacing Text 

ü To find a particular part of text in the page content: 

1 On the Edit tab, select the web page where you want to find the text.  

2 Click the  Find icon. 

3 On the Find tab, enter the text you want to find in the Find field.  

4 Indicate the area of the search, by selecting one of the following 
options: 

Á Entire text. Entire text on the web page will be searched for indicated word or 
phrase. 

Á Selection only. Only selected part of the text will be searched for indicated word 
or phrase. 

5 Indicate the direction of the search, by selecting one of the following 
options: 

Á Up. The search is done in the upper part of the text, starting from the cursor 
position. 

Á Down. The search is done in the lower part of the text, starting from the cursor 
position. 

6 Select the method of the search, by selecting either one of the 
following command options: 

Á Match case. Only the text that exactly matches the case (uppercase and 
lowercase character formatting) is searched for the specified search pattern. 

Á Match whole words only. Only the exact text you specified is searched for. 

7 Click OK to start the search. 

8 Click Find Next to look for the next mention of the search pattern. 

ü To find and then replace a word or phrase: 

1 Click the  Find icon in the editor toolbar. 

2 Click the Replace tab. 

3 Enter the text you want to replace in the Find field. 

4 Enter the replacement text in the Replace with field. 

5 Click Replace. 

6 To replace all the mentions of the search pattern in the text, click 
Replace All. 
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Checking Spelling 

ü To check spelling on the page: 

1 On the Edit tab, select the web page where you want to check the 
spelling. 

2 Click the  Spellchecker icon. 

In the Not in dictionary field, a possible spelling mistake is shown.  

3 If you are sure that the word found by the Spell Check editor is not 
misspelled, click Ignore to ignore this part of the text. 

To ignore all parts of the text, containing this word, click Ignore All.  

4 If you want to replace the misspelled word with the word in the 
Suggestions field, click Change. 

To change this word in the whole text, click Change All. 
 

Undoing and Redoing Actions 

To undo the last action, click the Undo icon.  

To redo the last undone action, click the  Redo icon. 
 




